Model Name: TBW-106
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Federal Communication Commission Interference Statement

This equipment has been tested and found to comply with the limits for a Class B digital device,
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection
against harmful interference in a residential installation. This equipment generates, uses and can
radiate radio frequency energy and, if not installed and used in accordance with the instructions, may
cause harmful interference to radio communications. However, there is no guarantee that
interference will not occur in a particular installation. If this equipment does cause harmful
interference to radio or television reception, which can be determined by turning the equipment off
and on, the user is encouraged to try to correct the interference by one of the following measures: .
Reorient or relocate the receiving antenna. . Increase the separation between the equipment and
receiver. . Connect the equipment into an outlet on a circuit different from that to which the receiver
is connected. . Consult the dealer or an experienced radio/TV technician for help. FCC Caution: To
assure continued compliance, any changes or modifications not expressly approved by the party
responsible for compliance could void the user's authority to operate this equipment. (Example - use
only shielded interface cables when connecting to computer or peripheral devices). This device and
it's antennas(s) must not be co-located or operating in conjunction with any other antenna or
transmitter except in accordance with FCC multi-transmitter product procedures. This device complies
with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may
not cause harmful interference, and (2) This device must accept any interference received, including
interference that may cause undesired operation.



Introduction

The Micro Bluetooth USB Adapter networks Bluetooth enabled devices such as cell phones, keyboards and
headsets.  The size of a penny, simply plug this micro-device into an available USB port on your laptop or
desktop and experience exceptional Bluetooth connectivity. Connect as many as 7 Bluetooth devices at
distances of up to 100m (328ft). Enhanced Data Rate (EDR) technology transfers your data quickly.
Adaptive Frequency Hopping (AFH) minimizes interference from other wireless technologies. This compact
device also provides secure encrypted data communication.

Features

e Connect Bluetooth-enabled devices such as printers, headsets, audio/video devices and mobile phones
» Compliant with Class | Bluetooth v4.0 and v3.0 specifications

* Enhanced Data Rate (EDR) support

* Bluetooth IVT software technology

* Adaptive Frequency Hopping (AFH) support

* Enhanced SCO (ESCO) for crisp and clear voice quality

» Compatible with Windows Vista2000/XP/7/8/8.1 and Media Center Edition operating systems

» Communicates wirelessly up to 100 meters (328ft.) (depends on environment)

* Trouble free Plug & Play installation

Package Contents

» TBW-106UB

» Multi-Language Quick Installation Guide
* CD-ROM (Driver and Utility)

System Requirements

¢ CD-ROM drive

e USB Port: 2.00r 1.1

® CPU: 1GHz or above (Windows 7) / 800MHz or above (Windows Vista) / 300MHz or above

e Memory: 1GB RAM or above (Windows 7)/ 512MB RAM or above (Windows Vista) /256MB RAM or
above (Windows XP/2000/)

¢ Hard Drive Space: 50MB or Above

e Windows/8.1/8/ 7/Vista/XP/2000

Installation



Note:
1. Do not insert the TBW-106UB USB adapter until instructed to do so.

2. If you have any Bluetooth driver (software) previously installed on your computer or built-in
Bluetooth device, please remove the driver and disable the built-in Bluetooth device first.

1. Insert the Utility & Driver CD-ROM into your

CD-ROM drive.
" & nutoriay E=ajicn =)

@ DVD RW Drive (D) TBW-106 UB

| Always do this for software and games:

Install or run program

2. Click Run Setup.exe (Windows 7/Vista). @) raseoee

General options
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el Uity

3. Click Install Utility.
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4. Select Language from the drop down menu.
Click OK.




) BlueSoleil 9.2.472.2 - InstallShield Wizard S

Welcome to the InstallShield Wizard for
BlueSoleil 9.2.472.2

The InstallShield(R) Wizard will install BlueSoleil 9.2.472.2 on
your computer. To continue, dick Next.

WARNING: This program is protected by copyright law and
international treaties.

BluesS" leil
5. Click Next
Al f Next > ncel
14 BlueSoleil 9.2.472.2 - InstaliShield Wizard ) ==

j

-

Bluesoleil End User License Agreement -

NOTICE TO USER: PLEASE READ THIS AGREEMENT
CAREFULLY. THE BLUESOLEIL END USER LICENSE
AGREEMENT (AGREEMENT) IS A VALID AND BINDING
AGREEMENT BETWEEN YOU, AS A USER, AND IVT
CORPORATION (IVT). BY USING ALL OR ANY PORTION OF THE
SOFTWARE, YOU ACCEPT ALL THE TERMS AND CONDITIONS

(@) 1accept the terms in the license agreement

() 1 do not accept the terms in the license agreement
6. Select I accept the term in the license instalshizid
agreement, Clike Next e S
41 BlueSoleil 9.2.472.2 - InstaliShield Wizard [ = |

InstaliShield Wizard Completed

The InstallShield Wizard has successfully installed BlueSoleil
9.2,472,2. Click Finish to exit the wizard,

>
7. Follow The installshield Wizard Bluetell
Instruction and the click Finish. — = B —
rﬁ! BlueSoleil 9.2.472.2 Installer Information | .|1

You must restart your system for the configuration
changes made to BlueSoleil 3.2.472.2 to take effect.

Click Yes to restart now or Mo if you plan to restart
later.

8. Click yes to restart the computer. If
you do not restart, some operations may be

F E i __No
abnormal.

9. Connect the TBW-106UB into the computer's
USB port.

10. Drivers will install automatically.




Getting Started

Operations
» To search for Bluetooth devices, double-click the My Device icon.

e To search for a Bluetooth device's services, double-click the Bluetooth device's icon.
e To connect to a Bluetooth device's service, click that device to select the device, and then
double-click the device's service icon.

My Device Icon Operations:
* Click the icon to select the local device and display its available services.

e Double-click the icon to search the Bluetooth devices.
» Right-click the icon to display a popup menu.

My Services Icons

Icon States:

» Connected. A remote device is connected with BlueSoleil under this service.
« Idle. The service is provided in the normal state.

« Disabled. The service is disabled.

Service lcon
Bluetooth Personal - - -
A i i
Area Network = k ‘*9
Bluetooth Serial
i S S 5
Bluetooth File %] L:.j ™
Transfer llg
Bluetooth Object =1 =l =
Push =] =] =1

Operations:
» Double-click the icon to view the status.
« Right-click the icon to display a popup menu so as to view the related operations.



Remote Devices Icons Icon States:
» Connected. The device is connected with your computer.

Device Icon
Headset @ ‘B ‘E—J @
Mobile Phone E @ g
ouse QO & O
Keyboard Sy -~ oy
— | & & &
Camera o)) @ \'i.m
PDA E[ ﬂ ﬂ
~
Video Device 32, ?;?/ ‘:?,
el IR
Desktop &Ad’f |, - JLEJ
Printer %‘J ﬁ &'rl
Unknown device Ql e 9/,

« Default. The device is set as the default device. (This state is only available for headsets.)
« Paired. The device has been paired with your computer successfully.
« Idle. The device is working in the normal state.

Operations:
» Double-click the icon to search the remote Bluetooth device's services.
* Right-click the icon to display a popup menu to view related operations.



Remote Devices' Services Icons
e Connected. The connection with the service has been established.

Icon States:

Service

lcon

Bluetooth Personal
Area Network

Bluetooth Serial
Port

Bluetooth File
Transfer

Bluetooth Object
Push

Bluetooth Advanced
Audio

Bluetooth Headset
and Microphone

Bluetooth Dial-Up
Networking

Bluetooth Human
Interface Device

Bluetooth Print

L
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™
T

A
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» Mute. The headset is set to be mute. (This state is only available for Bluetooth Headset and
Microphone services.)

« Idle. The remote service is provided in the normal state.
« Disabled. The service is unavailable since Bluetooth is not working.

Operations:
» Double-click the icon to connect with a remote device service.
« Right-click the icon to display a popup menu so as to view the related operations.

6 BlueSoleil starts up, but the Bluetooth function is not active. Operations
E'j Double-click the Bluetooth icon to open the BlueSoleil default window.

6 Click or right-click the Bluetooth icon to show popup menu.

Bluetooth Icon

There are three states of the Bluetooth icon in the notification area. --- BlueSoleil starts up and
Bluetooth function is active. --- There are existing Bluetooth connections.



Popup Menu

 Explore Bluetooth Places --- Open BlueSoleil with Windows explorer.

« Display Classic View --- Display BlueSoleil classic view window.

» My Device Properties --- View or change my Bluetooth device configurations.
 Turn on/off Bluetooth --- Turn on/off the Bluetooth function.

Menus

BlueSoleil classic view contains the following three menus: Bluetooth

« Search Devices --- Search Bluetooth devices nearby.

» My Device Properties --- Display properties of your local computer that is running BlueSoleil.
» Close --- Close BlueSoleil classic view window.

View
» Arrange Devices By --- Arrange searched Bluetooth devices by the name, status or type.

Help

« BlueSoleil Online Help --- Display BlueSoleil help document.

» Check for Update --- Access BlueSoleil website to check if any update available.

» Buy --- Open the BlueSoleil online store page to buy a license for current version.

« Register --- Make the current BlueSoleil copy to full version by entering the license key.
» About BlueSoleil --- Information about your version of BlueSoleil.

Start Bluetooth

1. Plug the Bluetooth Adapter into one of your computer's USB ports.
2. Turn on the Bluetooth function if you are using the built-in Bluetooth modules. 3.
BlueSoleil will start up.

Stop Bluetooth

To stop Bluetooth, you can:
« Right-click the Bluetooth icon in the notification area, and select Turn off Bluetooth.
« Right-click My Device icon, and select Turn off Bluetooth.

License Check

BlueSoleil checks the license in the Bluetooth adapter/module when it starts up. If the Bluetooth
adapter/module has no license, BlueSoleil will run in evaluation mode (5MB data limit).

Check Upgrade

During starting up, BlueSoleil will check the upgrade version on www.bluesoleil.com . If any upgrade
available, a tip message will pop up to prompt user the latest version information. User can visit the
site directly by clicking the link in the message to download and evaluate the new version. Tips:

« If you cannot find the Bluetooth icon in the notification area, check the following configuration: My
Device Properties -> Accessibility -> Notification, and select Show the Bluetooth icon in the
notification area check box.

e If the Bluetooth hardware is not found, the Bluetooth icon in the notification area will not be shown.
 To get the latest upgrade information, your computer must have the network connection to access
the Internet.



Using your Bluetooth Device

To establish a Bluetooth connection, you need to find the remote Bluetooth device first. Steps:
1. Make the remote device discoverable.

2. Double-click the My Device icon, namely, the orange ball in the center of the window.

3. Bluetooth devices will appear around the orbit, if discoverable.

Tips:

¢ Discoverable: A Bluetooth device always has two statuses, discoverable or non-discoverable. It can only be
searched in discoverable mode by other devices. The default mode of some mobile phones, headsets, mice,
keyboards is non-discoverable and you have to manually switch the mode to discoverable. To learn how to make a
device discoverable, check the information that came with your device.

¢ |f you want to stop searching devices, double-click the My Device icon, or right-click it and select Stop Searching in
the popup menu.

Search Remote Device Services

To communicate with a remote device for specified usage, you need obtain Bluetooth services
supported by the device which has been found. To do so, follow one of the methods below:
» Double-click the remote device icon.

« Right-click the device icon and select Search Services in the popup menu.

Bluetooth Security

To protect and prevent data from unauthorized access, a Bluetooth passkey is required before
communication. Once a remote device is paired with your computer by exchanging passkeys,
passkeys will no longer be required for further connections between your computer and the device.



Pairing with a Bluetooth device

Right-click the device icon to show the popup menu. Select Pair. In the Enter Bluetooth Passkey
dialog, enter the same passkey that you enter on the remote device. After a device is successfully
paired with your computer, the remote device icon will have a paired mark on it.

Un-pairing with a Bluetooth device

Right-click the device icon, and in the popup menu, select Unpair. The pairing relationship will be
removed. Tips:

* To pair with a Bluetooth keyboard, you should enter the passkey from the Bluetooth keyboard
directly. See "Bluetooth Keyboard" for more details.

« If you don't want to be asked to pair with devices when establishing connection, you can change the
secure connection setting as follows: a) If your computer initiates the connection: whether you input
the Bluetooth passkey depends on the device you are connecting to. If its security level is low or it
doesn't require a Bluetooth passkey, you don't need to enter it. b) If your computer accepts the
connection: double-click My Device -> right-click any service -> Properties -> uncheck the Secure
Connection check box.

Connections
Establishing a Connection

1. Search remote Bluetooth enabled devices.

2. Search services of the remote device.

3. Double-click any service icon to initiate the connection.

4. You might be prompted to enter a passkey to authenticate. Enter the same passkey on both sides,
or only enter the specific one provided by the device manufacturer on your computer side.



Terminating a Connection

Right-click the service icon of the remote service, and select Disconnect. Right-click the

service icon of the remote device, and select Disconnect xx service to terminate the service you are
connecting to.

Manage My Service
Starting a service

To receive connection from other devices via BlueSoleil, the service must be started. To do so, follow
these two steps:

1. Right-click the My Device icon in the center of Classic View and select Properties.

2. Select Service tab, and make sure that the service is not disabled in Status option.

Stopping a service

1. Right-click the My Device icon in the center of Classic View and select Properties.
2. Right-click a service icon and select Disable or click Disable button in Status dialog.

Disconnecting my service

Once your computer accepts other device's connection of Bluetooth File Transfer, Object Push,
Personal Area Network, or Serial Port, you can disconnect the connection on your computer side as
follow:

1. Click the My Device icon.

2. Right-click the connected service icon, select Status, and click the Disconnect button.



Connecting Bluetooth Devices
Bluetooth Headset

With a Bluetooth headset, you can enjoy music, or chat with others online wirelessly.

« Bluetooth Advanced Audio To listen to high-quality stereo music played in the computer.

« Bluetooth Headset and Microphone To use the headset as mono earplug and microphone to chat
with or make a VolP call to others.

To see further operations about the headset, click the following headlines:
ld .
ull ™

' Bluetooth Advanced Audio f\ Bluetooth Headset and Microphone

Tips:
» Some Bluetooth headsets only support Bluetooth Headset and Microphone service.
* When the headset battery is low on power, it may disconnect automatically.

Bluetooth Advanced Audio

This service enables users to listen to high-quality stereo music played in the computer.
1. Make your headset discoverable.

2. Search for your headset and connect to the Bluetooth Advanced Audio service.

3. Play music on computer.

Tip:

* You can control the player remotely with the button on your headset that supports Audio/Video
Remote Control Profile (AVRCP), such as play, pause, stop, previous, next, volume. Currently,
Windows Media Player, RealPlayer, Winamp are supported. For more players, visit
www.bluesoleil.com.



Bluetooth Headset and Microphone

This service enables users to enjoy the same functions as a wire earplug or microphone.

1. Place your headset in discoverable mode.

2. Search for your headset and connect to it with the Bluetooth Headset and Microphone service.
3. You can make a VolIP call to chat with others.

4. Right-click the Bluetooth Headset and Microphone icon and select Mute On to mute the chat.
Right-click and choose Mute Off to resume.

Tips:

* It is recommended not to listen to music with the Bluetooth Headset and Microphone service, this is
only telephony sound quality.

« BlueSoleil sets the last connected headset as the default headset automatically. When there is an
incoming VolP call, the default headset will be connected automatically.

Bluetooth Mobile Phone

You can connect your Bluetooth mobile phone to the computer wirelessly.

« Bluetooth File Transfer To transfer files to/from the shared folders in your mobile phone.

« Bluetooth Object Push To exchange cards with or send files to your mobile phone.

« Bluetooth Dial-Up Networking To dial-up to the Internet through your mobile phone via GPRS or
3G networks.

« Bluetooth FAX To send a fax from your computer through your mobile phone.

To see further operations about the mobile phone, click the following headlines:

Bluetooth File transfer

’I'l -l
—

.5“"] Bluetooth Object Push
A

' Bluetooth Dial-Up Networking

=/

fl...,
Bluetooth FAX

Tip: If you'd like to use BlueSoleil with Nokia PC Suite, please refer to Troubleshooting for
further details.

Bluetooth Keyboard

With BlueSoleil, a Bluetooth keyboard can be connected to your computer as a Human Interface
Device (HID).
» Connect the Bluetooth keyboard to a computer as an HID device.

1. Search for your Bluetooth keyboard and connect to it.

2. A passkey may be needed. Please enter the same passkey shown in the BlueSoleil pairing dialog
on Bluetooth keyboard and press Enter key to pair. (Figure 1)

3. The Bluetooth keyboard driver will be installed on the first time connection. After the driver
installation, the Bluetooth keyboard can be used as the computer-HID device.

4. The Bluetooth keyboard can be reconnected automatically, once you type any key on the
keyboard.



r 3
€3 Bluetoath Passkey{Bluetaoth-Keyboard 81FD16) (S0

A remote device needs a Bluetooth Passkey to create Paired
relationship for future connections. Please use the same -
passhkey on this device and also on the remote dzvice. "

Remote Device:  Bluetooth-Keyboard 81FD16

Address: 00:04:61:81:FD:16
Paaalucy: 31356
Time Left: 27s

Tips:

» To disconnect the keyboard permanently, right-click the Bluetooth keyboard icon and select Unplug
in the popup menu.

» The connection may not be set up if the Bluetooth keyboard battery is low on power.



Bluetooth Mouse

With BlueSoleil, a Bluetooth mouse can be connected to your computer as a Human Interface Device
(HID).

» Connect the Bluetooth mouse to a computer as an HID device.

1. Search for your Bluetooth mouse and connect to it.

2. A passkey may be needed. Please enter the default passkey of the mouse on BlueSoleil. See the
Bluetooth mouse's user manual for its default passkey.

3. The Bluetooth mouse driver will be installed on the first time connection. After the driver
installation, the Bluetooth mouse can be used as the computer-HID device.

4. The Bluetooth mouse can be reconnected automatically, once you click the mouse button.

Tips:

« To disconnect the mouse permanently, right-click the Bluetooth mouse icon and select Unplug in
the popup menu.

» The connection may not be set up if the Bluetooth mouse battery is low on power.

Remote Computer

With BlueSoleil, you can connect to other computers wirelessly.

« Bluetooth Advanced Audio. To listen to high-quality stereo music played in the remote
computer

« Bluetooth Basic Imaging Service  To send pictures to the remote computer.

« Bluetooth Personal Area Network To form a Bluetooth TCP/IP network.

« Bluetooth File Transfer To transfer files to/from the shared folders on the remote computer.

« Bluetooth Object Push To transfer a business card or other data between your computer and your
mobile phone.

« Bluetooth Serial Port To transfer data between computers.

To see further operations about the remote computer, click the following headlines:

i
o |

1
-
L

Bluetooth Advanced Audio

Bluetooth Basic Imaging Service

Bluetooth Personal Area Network



Bluetooth File transfer

Bluetooth Object Push

S |
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Bluetooth Serial Port

Bluetooth Advanced Audio

This service enables users to listen to high-quality stereo music played in the remote computer.
Steps:
1. Search for the remote computer and connect to the Bluetooth Advanced Audio service.

2. Play music on the remote computer and you can listen to the music on your local computer.

Bluetooth Basic Imaging Service

You can send pictures to the remote computer wirelessly
Steps:
1. Search for the remote computer.

2. Double-click the Bluetooth Basic Imaging Service icon and select a picture to send it to the
remote computer. You might be prompted to enter the passkey to authenticate before the
connection. Enter the same number on both computers sides.

Tip:

The pictures sent to the remote computer are saved at C:\Users\(User
name)\Documents\Bluetooth\BIP\DCIM by default. You can change the directory in the
Bluetooth Imaging Service properties in the remote computer side. See My Services Properties for
more details.

Bluetooth Personal Area Network

This service enables users to form a Bluetooth TCP/IP network to remote computers.

1. Search for the remote computer and connect to its Bluetooth Personal Area Network service.
2. The Bluetooth IP address of your local or remote computers will be assigned and shown as the
information tip.
3. You can access files and folders shared by the remote computers Bluetooth Personal Area Network
address.

Tips:
» To learn more about the Bluetooth Personal Area Network service and configuration BlueSoleil
provides, please refer to My Services Properties.



« If you can not access the other side's network after the connection is established, please make sure
that firewalls on both sides are shut off and you have the authority to access the remote computer.

« After connecting the Bluetooth Personal Area Network with remote computer (s), BlueSoleil
supports network games.

Bluetooth File Transfer

This service enables users to access folders shared by a remote computer.

1. Search for the remote computer and connect to it using the Bluetooth File Transfer service.
2. The computer's folder is displayed in your explorer window.

3. You can browse the folder and copy/paste the files.

Tips:
» The Bluetooth connection is terminated after the file transfer operation.

« To refresh the folder contents, right-click the blank space in the shared folder window and select
Update current folder in the popup menu.

» Some computers do not accept files copied to its folder via Bluetooth. Please refer to their user
manuals.

* Renaming a remote shared file or folder is not supported in BlueSoleil.



Bluetooth Object Push

This service enables users to exchange cards with a remote computer or send files to the remote
computer.

1. Search for your remote computer and search its services.

2. Right-click Bluetooth Object Push service of your remote computer. (Figure 1)

3. Select Send My Card in the popup menu to send your default name card to the remote computer.
4. Select Send Objects, select a file in the file dialog and send to your remote computer.

5. Select Exchange Cards to exchange your default name card with the remote computer. The default
card of the computer is also sent to your computer, stored in the user's incoming folder and imported
to Outlook.

6. Select Get Card to retrieve the default name card of the remote computer.

Send My Card
Send Objects
Exchanye Cards
Get Card

Status

Properties... I
Tips:
» Your default name card on the computer is a vCard in a .vcf file which can be created by exporting
from a contact in Outlook. See My Services Properties for more details.

» To send a file to a remote computer directly, you can right-click the file and select Send to ->
Bluetooth. See Bluetooth Object Transfer wizard for more details.

Bluetooth Serial Port

This service enables users to transfer data between computers.

1. Search for the remote computer and connect to its Bluetooth Serial Port service.
2. A new serial port will be installed the first time.

3. An information balloon will show you the outgoing serial port number.

4. Once connected, you can transfer data via the serial port.

Tip:
« If you open an installed serial port, BlueSoleil will establish the connection to the remote computer
automatically.

Bluetooth Printer

With BlueSoleil, you can print files to a Bluetooth printer wirelessly.
* Bluetooth Print To print files to a Bluetooth printer.
« Bluetooth Object Push To print a file by sending data to the Bluetooth printer directly.

To see further operations about Printer, click the following headlines:

- P
'gBluetooth Print é‘-:‘J Bluetooth Object Push

Bluetooth Print

This service enables users to print files to a Bluetooth printer wirelessly.

1. Search for the Bluetooth printer and double-click the Bluetooth Print service icon to start the add
printer wizard.

2. Choose Create a new port to create a BlueSoleil Printer Port. (Figure 1)

3. Install and connect the printer serial port in Connect Printer wizard. (Figure 2)

4. Choose the driver for your printer in Install the printer driver wizard. (Figure 3)

5. The printer is added.

6. You can print files to the new Bluetooth printer now. BlueSoleil will connect to the printer
automatically when the printer port is opened.



1 9 Connect Printer Wizard j IQ

Choose a printer port Search and Select Bluetooth Device
Search and select the Bluetooth device(s)in range. 5

A printer port is a type of connection that allows your computer to exchange information with a printer. Please select one device you wart to connect with
7 Use an existing port: LPT1: {Printer Port’ mf
(@ Create @ new port: Phatosmart

8200 series

Type of port: BlueSoleil Print Port -
Local Port

BiugSalei Print Port
Standard TCP/IP Port ‘

Device Type: Printer ;J

Search Devices
[ <Back ][ hNet> | [ Cancel Beck | Comeat | [ Ganedl |
== L

Install the printer driver Choose a printer port

7 Select the manufacturer and medel of your printer. i your printer came with an installation A printer port is & type of connection that allows your computer to exchange information with a prnter.
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Tips:
» Only Windows administrators are allowed to add a Bluetooth printer.
« If the BlueSoleil Print Port has been added, you can choose it for your printer in the Use an existing
port list. (Figure 4)
« Different types of Bluetooth printers may have different operating methods, please read your
printers' user manuals for more details.

Bluetooth Object Push

This service enables users to print a business card or a picture directly by sending them to the
Bluetooth printer.

* You can use Bluetooth Object Transfer Wizard to print a business card or a picture by sending them
to the Bluetooth printer directly.

* You can use Office Outlook Extended Functions to send a business card to the printer.



Bluetooth Modem

With BlueSoleil, your computer can connect to the Internet via a Bluetooth modem.
« Bluetooth Dial-Up Networking Connect to the Internet via a Bluetooth modem.

1. Make sure your Bluetooth modem is powered on and connects to the telephone line.

2. Search for the Bluetooth modem and connect to its Bluetooth Dial-Up Networking service.

3. A Bluetooth dial-up networking Modem driver will be installed on the first time connection.

4. The Dial-up networking dialog pops up. Enter your correct ISP phone number and click the Dial
button.

5. Once the dial-up connection is established, you can browse the Internet on your computer.

Bluetooth Access Point

With BlueSoleil, you can access the local area network via a Bluetooth access point.
« Bluetooth Personal Area Network Join in a local area network via a Bluetooth access point.

1. Make sure your Bluetooth access point is powered on and connected to the local area network.

2. Search for your Bluetooth access point and connect to its Bluetooth Personal Area Network service.
You might be prompted to enter the passkey of your access point. See the user manual that came
with your access point for the passkey.

3. After connected, an IP address will be assigned to your computer.

4. You can access the local area network now.

Tip:
« If you can not access the local area network after connection, please make sure the firewalls on your
computers are shut down and you have the authority to access the Bluetooth access point.



Bluetooth Object Transfer Wizard

Users can send files to mobile phones, remote computers and other Bluetooth devices via Send To
menu.

« Select a file or several files and right-click to send via Send To -> Bluetooth popup menu.

1. Select a file or several files. Right-click the files and select Send To -> Bluetooth to open the
Bluetooth Object Transfer Wizard. (Figure 1)

2. Choose a remote device you want to send files to.

3. Input a passkey if required.

4. After connection setup, transfer the files.

Open
QOpen With...

Share...

Festore previous versions

Send To Bluetooth
Cut i l;  Compressed (zipped) Folder
Copy Bl Desktop (create shortcut)
(h Documents
Create Shortcut iz FaxRecipient
Ielete 1 Mail Recipient

Fename

Froperties

Tips:
 Sending multi files at the same time is supported. Folders cannot be sent.
» The Send to function works differently in Windows XP and Windows Vista. Bluetooth Object
Transfer Wizard will popup directly after selecting Send To -> Bluetooth in Windows Vista; In
Windows XP, there are submenus including Other Devices and history remote devices list in Send To
-> Bluetooth. If you choose one of the history remote devices, the files will be sent to it directly; if you
choose Other Devices, the Bluetooth Object Transfer wizard will appear.

Office Outlook Extended Functions

BlueSoleil has an add-in for MS Office Outlook. You can set your default business card, send contacts
and mails to remote Bluetooth devices in Outlook directly.

» Set a business card as your default card in Outlook.

e Choose contacts, mails, notes or calendar in Outlook to send to a remote device.

1. Select a contact in your Outlook contacts. Select File -> Set as my default Business Card menu to
set as your computer's default business card.
2. Select a contact, a mail, a note or a calendar. Select File -> Send to Bluetooth Device. Select a
remote device to send the chosen information.

Start BlueSoleil Bluetooth Low Energy functions

1. First of all, you have to insert a dongle that supports BT4.0.
2. Please select “BLE functions” option to open BlueSoleil LE Ul.
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3. Please make your BT4.0 devices discoverable, and click “Add a device” search and co
nnect them.
Currently BlueSoleil can support Find Me, Proximity(these two belong to Alert), and
Health Thermometer, Heart Rate, Blood pressure, Glucose(these four belong to Healt
h) and HID OVER GATT Profile(this one belongs to Others).

Device Manager

Prodocis BlueSnoleil Life Cooperation

Bluetooth Phonebook -This service enables users to view the mobile phone's contacts,

backup, export, edit them and to send a message to the contacts.

1. Search for your mobile phone and double-click it to search available services.

2. Double-click the Bluetooth Phonebook icon. The contacts in your mobile phone will be shown
in the explorer window.

3. Double-click a contact to send him/her a message.

4. Backup/Recover your contacts: right-click the Bluetooth Phonebook icon and select Backup
Contacts or Recover Contacts in the popup menu (Figure 1). A file named "contacts_(Bluetooth
mobile phone name)_(date of backing up).dat" will be saved after clicking Backup Contacts. You
can undo the changes for your contacts through recovering.
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5. Create a new contact: right-click the blank of the window and select New Contact. (Figure 2)
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6. Edit a contact: right-click a contact and select Edit. (Figure 3)
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Tips:

Send by Message
Send to other Device...

For the phones with Symbian and Windows Mobile system, for example, some Nokia mobile phones,
BlueSoleil will send an application to your mobile phone via a message before the first connection to

Delete
Properties...
Figure 3
these phones. You should choose your phone's model, 'Upload' the application and install it at your
phone. (Figure 4)
6 Install Bluetooth Service Software [ihj
Manufacturer: Mokia
Maodel: W70
The mobile you selected is equipped with Symbian 05, pou need ta install the lastest Bluetooth
zervice software on your mobile. The software will uze the following features of wour mobile:
1. Connect with other bluetooth devices
2. Add and edit the contact or 5MS
3. Send SMS
4. Read the stored contacts or SkS
If you agree to uze it, please click "Upload”, software installation package will be sent ta your
mibile.
[ Upload I LCancel I

Figure 4

Right-click the mobile phone and select Properties. In the Model tab you can choose your mobile phone
type from the support list. If your mobile phone is not in the support list but supports PBAP function,
you can check Connect Bluetooth Phone Book Access Profile (PBAP) option to acquire the contact
list in your mobile phone. However, in this case you can only browse contacts in your phone and
backup the phone book, but cannot New/Edit/Delete contacts, or Get/Send messages. ( Figure 5)
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[¥]£onnect Blustooth Phone Book: Access Profile{PBAFPE

Using Bluetooth Phone Book Access Profile(FBAF), you can only
Get Contacts in your phone, but can not New/Edit/Delete
Contacts or Get/Send Messages.

= Figure 5

e At the first time when displaying the contacts, the Edit and Delete items in the contact's right-clicking
menu are unavailable. Please right-click the blank of the window and select Update Contacts.

e It is also strongly recommended that backup all your contacts in your phone and SIM card before your
select Recover Contacts, for the recovering process will delete the contacts first.

Bluetooth Messages - This service enables users to view messages, reply, forward them and

to export the messages.

1. Search for your mobile phone and double-click it to search available services.

2. Double-click the Bluetooth Messages icon. The messages in the mobile phone's inbox and sent
folder will be shown in the explorer window.

3. Create a new message: right-click the Bluetooth Messages icon and select New Message.
(Figure 1)
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Figure 1

4. Reply/forward a message: right-click a message and select Reply message or Forward message.
(Figure 2).
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Tips:

For the phones with Symbian and Windows Mobile system, for example, some Nokia
mobile phones, BlueSoleil will send an application to your mobile phone via a
message before the first connection to these phones. You should choose your
phone’ s model, ’Upload’ the application and install it at your phone. (Figure
3)

r 3
G Install Bluetooth Service Software &J
Marufacturer. Nokia
Model N70

The mobile you selected is equipped with Symbian 05, you need to install the lastest Blustoath
service software on your mobile, The software will use the following features of vour mobile:

1. Connect with other blustooth devices
2. Add and edit the contact or SM5

3 Send SMS

4. Read the stored contacts or SMS

If you agree to use it, please click "Upload", software installation package will be sent o your
mobile.

[ Upload I LCancel

C Figure 3

e At the first time when displaying messages, the Delete item in the message's right-clicking
menu are unavailable. Please right-click the blank of the window and select Update
Messages.



Troubleshooting

1. Why is the Bluetooth icon in Windows tray icon area gray when BlueSoleil starts up?

A: Your Bluetooth radio is not supported by your computer or BlueSoleil, or, Bluetooth is turned off.
2. What does "The Bluetooth device does not have proper license key. Bluetooth cannot start."
mean?

A: Your Bluetooth radio does not contain a valid license key authorized by IVT Corporation, so
BlueSoleil will stop working. For more details, please check BlueSoleil online support.

3. What is Bluetooth passkey?

A: Bluetooth passkey is used in the authentication procedure for Bluetooth security purpose. When a
remote device connects to your computer, it has to offer the same Bluetooth passkey as that you
input on your computer. Only when the Bluetooth passkeys from both sides are the same, connection
can be set_up. A paired relationship is created after a successful pairing, and the passkey is no longer
required for later connection. The paired relationship can be removed by any side.

4. What can | do if the connection has failed?

A: If the connection fails, the remote device may be in non-discoverable mode. Please make sure the
remote device is discoverable and try to connect again.

5. Why may | not send files to my device? A: Please make sure that your device supports File Transfer
or Object Push function, and it has enough space. Some devices accept limited types of files, such as
pictures and music only. Please also make sure that your file name does not contain characters that
cannot be recognized by your device.

6. Why | cannot add another Bluetooth printer with the same name?

A: BlueSoleil doesn't support multiple printers with the same name. In this case, the Windows OS
cannot tell which printer is the right one. Please rename one of the printers.

7. Does BlueSoleil support Windows multi-session?

A: Yes, BlueSoleil supports Windows multi-session. Different users logged in to Windows can all access
and use the Bluetooth function.

8. How do | use Nokia's PC Suite with BlueSoleil?

A: Please first make sure the version of your Nokia PC Suite is 6.5 or later. Here's how:

1. Start PC Suite, and select the connection type in Connection Manager to be Bluetooth (IVT
BlueSoleil).

2. PC Suite connection wizard will guide you to find your mobile phone, then you can connect your
phone to PC Suite via BlueSoleil.

3. Once connected, you can back up phone contents, synchronize contacts, calendar items, notes,
write, send and print text messages from your PC, install Symbian and Javatm applications from a PC
to a phone, and etc.



Specification

Standards

Antenna

Supported OS
Operating Voltage
Power Consumption

Temperature

Humidity

LED Indicator
Dimensions
Weights
Certification

Frequency
Module Technique

Profile Support

RF Output Power
Encryption
Receiving Sensitivity
Data Rate

Date Range

Class | Bluetooth v4.0 and v3.0 USB 2.0
Backwards compatible with Bluetooth v1.1, v1.2,
V2.0, V2.1, V3.0 and USB 1.1

Internal

Windows 8.1/8/ 7/Vista/XP/2000

5V (USB bus-powered)

Typical: 95mA,; idle: 12mA Tx max: 136mA
@19dBm; Rx max: 45mA

Operation: 0°~ 40°C (32°F~104°F) Storage:
-10°~ 65°C (14°F~149°F)

5%~95%RH (no condensation)

Single LED activity/connection

19x 12 x5.5mm (0.75 x 0.47 x 0.22 in.)
1.8g (0.063 0z.)

CE, FCC

2402-2480MHz

GFSK (Gaussian Frequency Shift Keying). /4
DQPSK, 8DPSK

DUN (Dial-up Networking) FAX Profile, BPP

( Basic Printing Profile) LAP (LAN Access Profile)
SPP (Serial Port Profile) GAP (Generic Access
Profile) HID (Human Interface Device) HCRP
(Hardcopy Cable Replacement Profile) FTP (File
Transfer Profile) OPP (Object Push Profile)
A2DP (Advanced Audio Distribution Profile)
GAVDP (Generic Audio/Video Distribution
Profile) HSP (Headset Profile) PAN (Personal
Area Networking) BIP (Basic Image Profile)
SYNC (Synchronization Profile) AV (Audio Video)
GOEP (Generic Object Exchange Profile)

6.49~8.85dBm (typical)

128 bit data encryption

- 82dBm ( typical)

Basic data rate: up to 723.2Kbps Enhanced data
rate: up to 3Mbps

Up to 100m (328 ft.)



Limited Warranty

TRENDnet warrants its products against defects in material and workmanship, under normal use and
service, for the following lengths of time from the date of purchase. TBW-106UB — 2 Years
Warranty AC/DC Power Adapter, Cooling Fan, and Power Supply carry 1 year warranty. If a product
does not operate as warranted during the applicable warranty period, TRENDnet shall reserve the
right, at its expense, to repair or replace the defective product or part and deliver an equivalent
product or part to the customer. The repair/replacement unit’s warranty continues from the original
date of purchase. All products that are replaced become the property of TRENDnet. Replacement
products may be new or reconditioned. TRENDnet does not issue refunds or credit. Please contact the
point-of-purchase for their return policies. TRENDnet shall not be responsible for any software,
firmware, information, or memory data of customer contained in, stored on, or integrated with any
products returned to TRENDnet pursuant to any warranty. There are no user serviceable parts
inside the product. Do not remove or attempt to service the product by any unauthorized service
center. This warranty is voided if (i) the product has been modified or repaired by any unauthorized
service center, (ii) the product was subject to accident, abuse, or improper use (iii) the product was
subject to conditions more severe than those specified in the manual. Warranty service may be
obtained by contacting TRENDnet within the applicable warranty period and providing a copy of the
dated proof of the purchase. Upon proper submission of required documentation a Return Material
Authorization (RMA) number will be issued. An RMA number is required in order to initiate warranty
service support for all TRENDnet products. Products that are sent to TRENDnet for RMA service must
have the RMA number marked on the outside of return packages and sent to TRENDnet prepaid,
insured and packaged appropriately for safe shipment. Customers shipping from outside of the USA
and Canada are responsible for return shipping fees. Customers shipping from outside of the USA are
responsible for custom charges, including but not limited to, duty, tax, and other fees.

WARRANTIES EXCLUSIVE: IF THE TRENDNET PRODUCT DOES NOT OPERATE AS



WARRANTED ABOVE, THE CUSTOMER’S SOLE REMEDY SHALL BE, AT TRENDNET’S OPTION, REPAIR OR
REPLACE. THE FOREGOING WARRANTIES AND REMEDIES ARE EXCLUSIVE AND ARE IN LIEU OF ALL
OTHER WARRANTIES, EXPRESSED OR IMPLIED, EITHER IN FACT OR BY OPERATION OF LAW,
STATUTORY OR OTHERWISE, INCLUDING WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE. TRENDNET NEITHER ASSUMES NOR AUTHORIZES ANY OTHER PERSON TO
ASSUME FOR IT ANY OTHER LIABILITY IN CONNECTION WITH THE SALE, INSTALLATION MAINTENANCE
OR USE OF TRENDNET’S PRODUCTS. TRENDNET SHALL NOT BE LIABLE UNDER THIS WARRANTY IF ITS
TESTING AND EXAMINATION DISCLOSE THAT THE ALLEGED DEFECT IN THE PRODUCT DOES NOT EXIST
OR WAS CAUSED BY CUSTOMER’S OR ANY THIRD PERSON’S MISUSE, NEGLECT, IMPROPER
INSTALLATION OR TESTING, UNAUTHORIZED ATTEMPTS TO REPAIR OR MODIFY, OR ANY OTHER
CAUSE BEYOND THE RANGE OF THE INTENDED USE, OR BY ACCIDENT, FIRE, LIGHTNING, OR OTHER
HAZARD. LIMITATION OF LIABILITY: TO THE FULL EXTENT ALLOWED BY LAW TRENDNET ALSO
EXCLUDES FOR ITSELF AND ITS SUPPLIERS ANY LIABILITY, WHETHER BASED IN CONTRACT OR TORT
(INCLUDING NEGLIGENCE), FOR INCIDENTAL, CONSEQUENTIAL, INDIRECT, SPECIAL, OR PUNITIVE
DAMAGES OF ANY KIND, OR FOR LOSS OF REVENUE OR PROFITS, LOSS OF BUSINESS, LOSS OF
INFORMATION OR DATE, OR OTHER FINANCIAL LOSS ARISING OUT OF OR IN CONNECTION WITH THE
SALE, INSTALLATION, MAINTENANCE, USE, PERFORMANCE, FAILURE, OR INTERRUPTION OF THE
POSSIBILITY OF SUCH DAMAGES, AND LIMITS ITS LIABILITY TO REPAIR, REPLACEMENT, OR REFUND OF
THE PURCHASE PRICE PAID, AT TRENDNET’S OPTION. THIS DISCLAIMER OF LIABILITY FOR DAMAGES
WILL NOT BE AFFECTED IF ANY REMEDY PROVIDED HEREIN SHALL FAIL OF ITS ESSENTIAL PURPOSE.
Governing Law: This Limited Warranty shall be governed by the laws of the state of California.



TRENDNET

Product Warranty Registration

Please take a moment to register your product online.
Go to TRENDnet's website at http://www.trendnet.com/register
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